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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider PaeTec and Avaya IP Office 7.0.

PaeTec SIP Trunking provides PSTN access via a SIP trunk between the enterprise and the
PaeTec network as an alternative to legacy analog or digital trunks. This approach generally
results in lower cost for the enterprise.

PaeTec is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between service provider PaeTec and an Avaya IP Office solution. In the sample
configuration, the Avaya IP Office solution consists of an Avaya IP Office 500v2 Release 7.0,
Avaya Voicemail Pro, Avaya IP Office Softphone, and Avaya SIP, H.323, digital, and analog
endpoints.

The PaeTec SIP Trunking service referenced within these Application Notes is designed for business
customers. The service enables local and long distance PSTN calling via standards-based SIP trunks
as an alternative to legacy analog or digital trunks, without the need for additional TDM enterprise
gateways and the associated maintenance costs.

The PaeTec SIP Trunking service requires the enterprise IP PBX to Register with the SIP network
via SIP credentials. This authentication scheme, as specified in SIP RFC 3261, provides security
and identity verification for SIP signaling between the service provider and the enterprise.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to PaeTec SIP Trunking service. This configuration (shown in Figure 1) was used to
exercise the features and functionality tests listed in Section 2.1.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya I[P Office was connected to PaeTec SIP Trunking service. To
verify SIP trunking interoperability, the following features and functionality were exercised during
the interoperability compliance test:

e Registration to the PaeTec SIP network.

e Response to SIP OPTIONS queries.

e Incoming PSTN calls to various phone types. Phone types included SIP, H.323, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included SIP, H.323, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls to/from the Avaya IP Office Softphone.

e Inbound and outbound long hold time call stability.

e Various call types including: local, long distance, international, outbound toll-free, operator
service and directory assistance.

e Codec G.711MU and G.729A.

e Caller number/ID presentation.

e Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

e DTMF transmission using RFC 2833.
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e Voicemail navigation for inbound and outbound calls.

e Telephony features such as hold and resume, transfer, and conference.
e Off-net call forwarding.

e Twinning to mobile phones on inbound calls.

2.2. Test Results
PaeTec SIP Trunking passed compliance testing.

Items not supported or not tested included the following:
e Inbound toll-free and outbound emergency calls (911) are supported but were not tested as
part of the compliance test.
e Faxing between the enterprise site and PSTN was tested over G.711MU as part of the
compliance test but was not tested using t.38 since PaeTec does not currently support T.38
FoIP (Fax over IP) on its SIP Trunking production system.

e Interoperability testing of PaeTec SIP Trunking was completed with successful results for all
test cases.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

For technical support on PaeTec SIP Trunking, contact PaeTec at http://www.paetec.com/

3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to PaeTec SIP Trunking service through the public IP network.

Located at the enterprise site is an Avaya [P Office 500v2 with the COMBO6210/ATM4 expansion
card which provides connections for 6 digital stations, 2 analog stations, 4 analog trunks to the PSTN
as well as 10-channel VCM (Voice Compression Module) for supporting VoIP codecs. The LAN
port of Avaya IP Office is connected to the enterprise LAN while the WAN port is connected to the
public IP network. Endpoints include an Avaya 1600 Series IP Telephone (with H.323 firmware),
an Avaya 1120e Series IP Telephone (with SIP firmware), an Avaya 1408 Digital Telephone, an
Avaya Analog Telephone and an Avaya IP Office Softphone. The site also has a Windows 2003
Server running Avaya Voicemail Pro for providing voice messaging service to the Avaya IP Office
users. A separate Windows XP PC runs Avaya [P Office Manager to configure and administer the
Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user
phones will also ring and can be answered at the configured mobile phones.
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Figure 1: Test Configuration for Avaya IP Office with PaeTec SIP Trunking Service

For security purposes, the real public IP addresses and PSTN routable phone numbers used in the
compliance test are masked in these Application Notes.

For the purposes of the compliance test, Avaya IP Office users dialed a short code of 9 + N digits to
send digits across the SIP trunk to PaeTec. The short code of 9 was stripped off by Avaya IP Office
but the remaining N digits were sent unaltered to PaeTec. For calls within the North American
Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus for these NANP calls, Avaya
IP Office would send 11 digits in the Request URI and the To headers of an outbound SIP INVITE
message. [P Office was configured to send 10 digits in the From and PAI headers. For inbound
calls, PaeTec SIP Trunking sent 10 digits in the Request URI, To, and From headers of inbound SIP
INVITE messages.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and Avaya IP Office such as a session border controller or
data firewall. A complete discussion of the configuration of these devices is beyond the scope of
these Application Notes. However, it should be noted that SIP and RTP traffic between the service
provider and Avaya IP Office must be allowed to pass through these devices.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components
Equipment Release
Avaya [P Office 500v2 7.0 (5)
Avaya IP Office COMBO6210/ATM4 7.0 (5)
Module
Avaya Voicemail Pro 7.0.17
Avaya [P Office Manager 9.0 (5)
Avaya 1616 IP Telephone (H.323) Avaya one-X Deskphone Value Edition 1.2.2
Avaya 1120E IP Telephone (SIP) SIP1120 version 04.01.13.00
Avaya 1408 Digitial Telephone N/A
Avaya Analog Telephone N/A
Avaya IP Office Softphone 3.1.2.17 59616
PaeTec SIP Trunking
Equipment Release
Acme Packet Net-Net 4250 SBC Firmware SC6.2.0 Patch 3 (Build 497)
BroadWorks Soft Switch Rell4.sp9. 1.123
Media Gateways
e Lucent LCS 3.14.4.7
e (Genband G9 7.3 Bundle 403

5. Configure IP Office

This section describes the Avaya IP Office configuration to support connectivity to PaecTec SIP
Trunking service. Avaya [P Office is configured through the Avaya IP Office Manager PC
application. From a PC running the Avaya IP Office Manager application, select Start =
Programs - IP Office = Manager to launch the application. Navigate to File > Open
Configuration, select the proper Avaya IP Office system from the pop-up window, and log in with
the appropriate credentials. A management window will appear similar to the one shown in the next
section. The appearance of the [P Office Manager can be customized using the View menu. In the
screens presented in this section, the View menu was configured to show the Navigation pane on the
left side, the Group pane in the center, and the Details pane on the right side. These panes will be
referenced throughout the Avaya IP Office configuration. Proper licensing as well as standard
feature configurations that are not directly related to the interface with the service provider (such as
LAN interface to the enterprise site and IP Office Softphone support) is assumed to be already in
place.

5.1. LAN2 Settings

In the sample configuration, the MAC address 00E00705B33F was used as the system name and the
WAN port was used to connect the Avaya [P Office to the public network. The LAN2 settings
correspond to the WAN port on the Avaya IP Office. To access the LAN2 settings, first navigate to
System (1) = 00E00705B33F in the Navigation and Group panes and then navigate to the LAN2->

ALW; Reviewed: Solution & Interoperability Test Lab Application Notes 5of27
SPOC 8/6/2011 ©2011 Avaya Inc. All Rights Reserved. PaeTecSipTIPO7



LAN Settings tab in the Details pane. Set the IP Address field to the IP address assigned to the
Avaya IP Office WAN port. Set the IP Mask field to the mask used on the public network. All
other parameters should be set according to customer requirements.
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Select the VoIP tab as shown in the following screen. The SIP Trunks Enable box must be
checked to enable the configuration of SIP trunks to PaeTec. The RTP Port Number Range can be
customized to a specific range of receive ports for the RTP media. Based on this setting, Avaya IP
Office would request RTP media be sent to a UDP port in the configurable range for calls using
LAN2. Avaya IP Office can also be configured to mark the Differentiated Services Code Point
(DSCP) in the IP Header with specific values to support Quality of Services policies for both
signaling and media. The DSCP field is the value used for media and the SIG DSCP is the value
used for signaling. The specific values used for the compliance test are shown in the example
below. All other parameters should be set according to customer requirements.

IP Offices System Ei 0OE00705B33F* EREIR2EN
!
R BooTP(3) =l System | LAM1 | LAMZ | DNS || Voicemail | Telephony | Directory Services | System Events | SMTP | SMOR | Twir 4 ¥
7 Operator (3) %7 00EQO70SEI3F
-y LAM Settings | YoIP | Ketwork Topology
L/ .
T4 Line () . [] H323 Gatekesper Enable
<2 Control Unit {4)
Ay Extension (223 SIP Trunks Enable
§ User(e3) [] s1r Reqistrar Enable
;a HunkGroup {3)
#% Short Code (58)
@ Service (0) = RTF Pork Mumber Range
H323 Auto-create Extn
oy RAS Q) Port Range (Minimumy (49152 %
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Eﬁ WanPork {0} [ Hz23 Auto-create User Port Range (Maximum) (53246 5
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f’.“‘ Tirme Profile {00 Enable RTCP Manitoring
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[l 1P Rouke (3) DiffSery Settings
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. Licence (64) B8 3| DSCP{Hex) [FC 3| DSCPMaskiHex) [88 | SIGDSCP (Hex)
B Tunnel () 4% % pscp 63 4| DICP Mask 3 4| siapsce
ﬁ‘, User Rights (8)
@ Adto Attendant (0) DHCP Settings
EARS (L) i ) I =
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= E911 System (1) Secondary Site Specific Option Murnber (SSOM) 242 £
WLAN Mot Present hd
1100 Yoice YLAM Site Specific Option Number (530N 232 |
1100 Yoice YLAN IDs
RTP Keepalives
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3 alz o OF ] ’ Cancel ] ’ Help
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On the Network Topology tab in the Details pane, configure the following parameters:

o Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Sect Binding Refresh Time (seconds) to 60. This value is used as one input to determine the
frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider. See Section 5.10 for complete details.

e Set Public IP Address to the IP address of the Avaya IP Office WAN port.

e All other parameters should be set according to customer requirements.

Ei OOEQ0705B33F" g -1 X vl ]

Systern | LAM1 | LAMZ | DNS || Yoicemail || Telephony | Directory Services | Syskem Events | SMTP || SMOR | Tw 4 *
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STUM Server IP Address a9 a0 1685 13 STUM Park 3478 )
FirewalliMAT Type Cpen Inkernet L

Binding Refresh Time &0 =
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Public Part S0s0 % Run STUM Cancel

|:| Fun STUM on starkup
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In the compliance test, the LAN1 interface was used to connect the Avaya IP Office to the enterprise
site IP network. The LANI1 interface configuration is not directly relevant to the interface with
PaeTec SIP Trunking service, and therefore is not described in these Application Notes.

ALW; Reviewed: Solution & Interoperability Test Lab Application Notes 8 of 27
SPOC 8/6/2011 ©2011 Avaya Inc. All Rights Reserved. PaeTecSipTIPO7



5.2. System Telephony Settings

Navigate to the Telephony = Telephony tab in the Details pane. Set the Automatic Codec
Preference for the default codec to be used for intra-enterprise traffic. Choose the Companding
Law typical for the enterprise location. For North America, ULAW is used. Uncheck the Inhibit
Off-Switch Forward/Transfer box to allow call forwarding and call transfer to the PSTN via the
service provider across the SIP trunk.

Ei 00E00705B33F* =MREIEAEN
Swstem | LAM1 || LAMZ | DMS Yoicemail | Telephory Direckary Services | System Events | SMTP | SMDR || Twir € *
Telephony | Tones & Music | Call Lag
Analogue Extensions Companding Law -
Switch Lire
Default Qutside Call Sequence Marrnal w
Default Inside Call Sequence Ring Tvpe 1 W @ uLaw ®
Default Ring Back, Sequence Ring Tvpe 2 W O aaw o
Restrict Analogue Extension Ringer Yolkage [ ]
Dial Delay Time (secs) 4 - [] pss status
Dial Delay Count 0 " Auka Hold
Cefault Mo Answer Time (secs) 15 2 _ Diial By Marne
Hald Timeout (secs) 120 % Show Account Code
Park Timeout {secs) 300 % [ 1nhibit Off-Switch Forward) T
Ring Delay (secs) 5 = |:| Restrict Metwork Interconne
Zall Priority Promotion Time {secsi | Disabled - [ Drop External Only Impromp
Default Currency LSO 2 [] visually Differentiate Extern:
Automatic Codec Preference 3, 729(a) 8K CS-ACELP W
w
£ >
Ik l [ Cancel l [ Help
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5.3. Twinning Calling Party Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two
parameters. The first parameter is the Send original calling party information for Mobile
Twinning box on the System-> Twinning tab. The second parameter is the Send Caller ID
parameter on the SIP Line form (shown in Section 5.4).

If Send original calling party information for Mobile Twinning on the System—> Twinning tab is
set, the setting of the second parameter is ignored and Avaya IP Office will send the following in the
SIP From Header:

e On calls from an internal extension to a twinned phone, Avaya IP Office will send the calling
party number of the originating extension.

e On calls from the PSTN to a twinned phone, Avaya IP Office will send the calling party
number of the host phone associated with the twinned destination (instead of the number of
the originating caller).

The above behavior in Avaya IP Office Release 7 is the same as in Avaya [P Office Release 6 and
was tested and verified in the compliance test.

Avaya IP Office Release 7 also provides an alternative method of sending caller ID through SIP
Diversion header (configured via unchecking Send original calling party information for Mobile
Twinning here then selecting Diversion Header for the Send Caller ID parameter on the SIP Line
form in Section 5.4). This alternative configuration could provide more accurate caller ID
information if the service provider supports the SIP Diversion header (not tested in the compliance
test).

For the compliance test, the Send original calling party information for Mobile Twinning box in
the System—> Twinning tab was checked which overrides any setting of the Send Caller ID
parameter on the SIP Line form.
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5.4. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and PaeTec SIP

Trunking service. To create a SIP line, begin by navigating to Line in the left Navigation pane, then
right-click in the Group pane and select New => SIP Line. On the SIP Line tab in the Details pane,
configure the parameters as shown below:

e Set ITSP Domain Name to the enterprise domain, or the IP address of the IP Office WAN
interface, so that IP Office uses this domain / [P address as the host portion of SIP URI in SIP

headers such as the From header.

e Set Send Caller ID to None. For the compliance test, this parameter was ignored since Send
original calling party information for Mobile Twinning is optioned in Section 5.3.

e Check the In Service box.

e Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS
method to periodically check the SIP line.

e Default values may be used for all other parameters.

The area of the screen entitled REFER Support is used to enable/disable SIP REFER for call
transfers. The default values of “Auto” for Incoming and Outgoing effectively disable use of SIP
REFER. To enable SIP REFER, select “Always” from the drop-down menu for Incoming and

Outgoing.
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Select the Transport tab. The ITSP Proxy Address is set to the PaeTec SIP Proxy IP Address
provided by PaeTec, as shown in Figure 1. This [P Address is 64.1.1.220. In the Network
Configuration area, UDP is selected as the Layer 4 Protocol, and the Send Port is set to the port
number provided by PaeTec. The Use Network Topology Info parameter is set to LAN 2. This
associates the SIP line with the parameters in the System = LAN2 - Network Topology tab.

Other parameters retain default values in the screen below.

Eij SIP Line - Line 17 ek X vlels
SIP Line | Transport |SIP URI| YoIP || T35 Fax| SIP Credentials
ITSP Proxy Address  |64.1.1.220
Metwork Configuration
Layer 4 Protocal LDP w Send Port [(S060 -
Use Metwork Topology Infoo |LAN 2 w
Explicit DNS Server(s) ] 1] 1] 1] a0 1 n n
alls Route via Registrar
Separate Regiskrar
Ik l ’ Cancel l ’ Help
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A SIP Credentials entry must be created for Digest Authentication used by PaeTec SIP trunking
service to authenticate Registration of the IP PBX for calls from the enterprise to the PSTN. To
create a SIP Credentials entry, first select the SIP Credentials tab. Click the Add button and the
New SIP Credentials area will appear at the bottom of the pane . To edit an existing entry, click an
entry in the list at the top, and click the Edit... button. In the bottom of the screen, the Edit SIP
Credentials area will be opened. In the example screen below, a previously configured entry is

edited. The entry was created with the parameters shown below:

e Set User name and Authentication Name to the value provided by the service provider.
e Set Password to the value provided by the service provider if required. (NOTE: PaeTec did

not require a password for the compliance test).

e Check the Registration required option. PaeTec requires registration of the IP PBX for the

SIP trunking service.

£ SIP Line - Line 17*
SIP Line||[Transport| SIP URI|| YoIP | T38 Fax| SIP Credentials

Index  Userfame Authentication Mame | Contact  Expiry  Redisker
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v | <=

Add. ..

Remove
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A SIP URI entry must be created to match each incoming number that Avaya IP Office will accept
on this line. Select the SIP URI tab, and then click the Add button, the New Channel arca will
appear at the bottom of the pane. To edit an existing entry, click an entry in the list at the top, and
click the Edit... button. In the example screen below, a previously configured entry is edited. For
the compliance test, a single SIP URI entry was created that matched any DID number assigned to
an Avaya [P Office user. The entry was created with the parameters shown below:

Set Local URI, Contact and Display Name to Use Internal Data. This setting allows calls
on this line for SIP URIs that match the number set in the SIP tab of any User as shown in

i) SIP Line - Line 17 =MEISEARN

SIP Line | Transport| SIF URL oI | T38 Fax| SIP Credentials

Section 5.6.

Set PAI to Use Internal Data. With this setting IP Office will populate the SIP P-Asserted-
Identity header on outgoing calls with the data set in the SIP tab of the User initiating the
call as shown in Section 5.6.
For Registration, select the account credentials previously configured on the line's SIP
Credentials tab.
Associate this line with an incoming line group in the Incoming Group field. This line
group number will be used in defining incoming call routes for this line. Similarly, associate
the line to an outgoing line group using the Outgoing Group field. For the compliance test, a
new incoming and outgoing line group 17 was defined.
Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

Channel  Groups
1 17 17

Edit Channel
Via

Local URI
Contack

Displaw Marne
PAIL
Reqgistrakion
Incaming Graup
Cukgoing Group

Max Calls per Channel

Via Local URI  Contact  Display Mame  PAI | Credential

Booc 1: 7135...
205.1.1.19
Use Internal Data w
Use Internal Data “
Use Internal Data w
Use Internal Data “
1: 7135553763 -
17
17
10 =

Max Calls Add...
10
Remowve

Edit...
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Select the VoIP tab to set the Voice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Compression Mode was configured using the Advanced button, allowing an explicit
ordered list of codecs to be specified. Check marks next to G.729(a) 8K CS-ACELP and
G.711 ULAW codecs cause Avaya [P Office to include these codecs, supported by the
PaeTec SIP Trunking service, in the Session Description Protocol (SDP) offer, in that order.

e Setthe DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP event messages as defined in RFC2833.

e Uncheck the VoIP Silence Suppression box. By unchecking the VoIP Silence Suppression
box, calls can be established with the G.729 codec but without silence suppression.

e Select G.711 for Fax Transport Support. T.38 faxing is not currently supported by PaeTec.
G.711 pass-through faxing is supported by PaeTec and was successfully tested. G.711
should be selected here.

e Check the Re-invite Supported box.

e Default values may be used for all other parameters.

= SIP Line - Line 17 ek X v <]
SIP Line| Transpark| SIP URI| YoIP  |T55 Fax||SIP Credentials
Compression Mode 3.729(a) 8K C5-ACELP [] valF Silence Suppressian
(2. 711 LILAwW B4k Re-invite Supported
.
O Use Offerer's Preferred
[] coder Lockdown
Fax Transpork Support 3,711 b
Call Initiation Timeout (s) = -
DTMF Suppork RFZ2833 p
< ¥
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5.5. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, select Short
Code in the left Navigation pane, then right-click in the Group pane and select New. On the Short
Code tab in the Details pane, configure the parameters for the new short code to be created. The
screen below shows the details of the previously administered “9ON” short code used in the test
configuration.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 9N. This short code will be invoked when the user dials 9 followed by
any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Sect Telephone Number to N”@64.1.1.220”. This field is used to construct the Request URI
and To headers in the outgoing SIP INVITE message. The value NNV represents the number
dialed by the user. The host part following the “@” is the domain or IP address of the service
provider network.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.4. This short code will use this line group when placing the outbound

call.
o | oo B evos  CESIEIEEE
K BoOTR (3) Code Telepho.,.. | Feature (1| sho code
i Operator (3) x40 1 Relay Ofl
=% O0EOO7OSESSF kg1 1 Relay Pul Code aM
20 System (1) x4z 2 Relay On -
9 Line (5} P z Relay OFl Feature Dl bt
<2 Control Uniit (4) P*aq 2 Relay Pul Telephone Mumber  |M'@&4.1.1.220"
A Extension (22) PXracHE N call Steal
‘: User (23} x+ag call Steal Line Group Id 17 w
2 ;':zrttG?oLéi((?g) 047 Co.nfere!' Locale United States (US English) -
@ service (0) Bxdg Yoicemail - ¢ Code []
o, RAS (1) x4 Yoicemail -
e Incoming Call Route {4) 9250 Forward
#2) WanPort (1) Ixsy Farward
s Directory (0) 95z Clear Cal
£ Time Profile (0) PFSINE N Call Picku
@ Firewal Profile (1) PHSTE N Farward
BB 1P Route (3) PRETORNE N Dial Phys
@ Account Code (0) BTINE N Dial Phys
W Licence (64) B+0000*  "MAIMTE... Relay On
& Turnel (0) [ LT T T Record ¥
§ User Rights (3) oazn; 2 Record I
{8 Auto Attendant (0) PX+0SsH [09151...  Display ¥
K ARS(1) BX*sDN 0151, Display
f RAS Location Request (0} Sk "[0}151... Display I
fx E911 System (1) o N Dial
an; WH'@6..,  Dial
oon N@ed.. Dl o,
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The simple “ON” short code illustrated above does not provide a means of alternate routing if the
configured SIP line is out of service or temporarily not responding. When alternate routing options
and/or more customized analysis of the digits following the short code are desired, the Automatic
Route Selection (ARS) feature may be used. In the following example screen, the short code 6N is
illustrated for access to ARS. When the Avaya IP Office user dials 6 plus any number N, rather than
being directed to a specific Line Group Id, the call is directed to Line Group ID “50: Main”,
configurable via ARS. See Section 5.8 for example ARS route configuration for “50: Main” as well
as a backup route.

= 6N: Dial =SAR ARAEAE

| Short Code |
Code M
Feature Dial »

Telephone Murmber N
Line Group Id ESEI: flain |

Locale »

Force Account Code [ ]
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5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.4. To configure these settings, first select User in the left Navigation pane, then
select the name of the user to be modified in the center Group pane. In the example below, the name
of'the user is H323 1616. Select the SIP tab in the Details pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4). The
example below shows the settings for user H323 1616. The SIP Name and Contact are set to one of
the DID numbers assigned to the enterprise from PaeTec. The SIP Display Name (Alias) parameter
can optionally be configured with a descriptive name. If all calls involving this user and a SIP line
should be considered private, then the Anonymous box may be checked to withhold the user’s
information from the network.

IP Offices User B H323 1616: 301 ek X vl<l>
. Extensi
R sootr = s Mobility | Phone Manager Options | Hunt Group Membership | Announcements | 31P Personal Directory A
i Operator (3) Analog Phone 7023
= -+ OOEDO7OSE33F Digital 1408 77022 SIP Name 7133433765
sy System (1) e Extn30z 302 X .
7 Line (5) Extniang an3 SIP Display Mame (alias) |H3Z3 1616
<= Contral Unit (4) Extn77023 77023 Contact 7133433765
< Extension (22) Extn77024 77024
§ ser(z3) Extn77025 77025
;’E ;':”ttGEDL"jD (é)g) Extn77026 77026 [ Anonymous
o ose Extn77027 77027
B service () Extn77029 77029
ol RAS (1) n
@ Incoming Call Route (4] Extn77030 77030
£ wanPort (1) Extn77031 77031
= Directory (0) Extn77032 77032
£7 Time Prafile (0} Extn77033 77033
@& Firewall Profile (1) Extn77034 7034
[l TP Route (3) Extn77035 77035
am Account Code (0) Exkn7 7036 FT036
W Licence (64) Extn77037 77037
% Tunnel {0} rTH3Z3 1616 301
§_‘. User Rights (8} = IPO Softphone 307
@ Auto Attendant (0) frmhialiser
AR5 (1) ) :RemoteManager
" RAS5 Location Request aHSIP 1120E 401
gx E911 System (1)
< »£ >
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One of the H.323 IP phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User H323 1616. The Mobility Features and Mobile Twinning
boxes are checked. The Twinned Mobile Number field is configured with the number to dial to
reach the twinned mobile telephone. Other options can be set according to customer requirements.

5|
H323 1616: 301 Bf - | X | v | <=
Mability | phone Manager Options | Hunt Group Membership | Announcements | SIP Personal Direckory 4
] 1nternal Twinning
Twin Bridge Appearances
Twin Coverage Appearances
Twin Line Appearances
Mability Features
Mobile Twinning
T.winngd quile hurnber 017205558022
(including dial access code)
Twinning Time Profile <Mone = w
Mabile Dial Delay {secs) 2
Mobile Answer Guard (secsy |0 e
Hunt group calls eligible For mobile bwinning
[ ] Forwarded calls eligible For mobile bwinning
[ Twin When Logged Out
[ one-% Mobile Client
[ ] Mobile Call Contral
Mobile Callback,
£ >
Ik ] ’ Cancel ] ’ Help
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5.7. Incoming Call Route
An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, select Incoming Call Route in the left Navigation pane, then right-click in
the center Group pane and select New. On the Standard tab of the Details pane, enter the
parameters as shown below:

e Set the Bearer Capability to Any Voice.

e Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.4.

e Set the Incoming Number to the incoming number on which this route should match.

e Default values can be used for all other fields.

IP Offices Incoming CallRo... | 17 7133433765 g - X[ v <]

R BOOTP (3) Line Group Id | Incoming Numba || ckandard | yoice Recording | Destinations
i Operator (3) QD
—|-#3y DDEOOFOSESSF BU Bearer Capability Any Yoice v
&) System (1) @17 7133433764 Line Group Id 17 Z
T4 Line (5) @17 7133433765
< Control Unit (4) Incoming Murmber 7133433765

A%y Extension (22)
= User (23) Incoming Sub Address

ﬂ HuntiEroup (3)

B3 Short Code (59) Incoming CLI

B service () Locale United States (LS English) v
ol RAS (1)
p Incoming Call Raute (4] Priority 1-Law v

@ ‘WanPort {0}
a4 Directory (0)
71 Time: Profile (0) Hold Music Source System Source v
& Firewall Profile (1)
BB IF Route (3)

| Account Code (0}
W Licence (64)

i Tunnel {03

ﬁ‘, User Rights (8)

@ Auto Attendant (0)
¢ RS (1)

" RAS Location Request
fx E911 System (1) 3

Tag

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. In this example, incoming calls to 713-343-3765 on line 17 are routed to
extension 301.

Incoming Call Ro... E 17 7133433765 - X[ wv]|<]=>

Line Group Id | Incoming MNumbg Standard | Vaice Recarding | Destinations

u]
gﬂ TimnePrafile Destination Fallback Extension
el? 7133433764 » Default Yalue 301 H323 1616 » | 301 H323 1616 ¥
D17 7133435765

: >
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5.8. ARS and Alternate Routing

While detailed coverage of Automatic Route Selection (ARS) is beyond the scope of these
Application Notes, this section includes basic ARS screen illustrations and considerations. ARS is
illustrated here mainly to illustrate alternate routing should the SIP line be out of service or
temporarily not responding.

Optionally, ARS can be used rather than the simple “ON” short code approach documented in
Section 5.5. With ARS, a secondary dial tone can be provided after the access code, time-based
routing criteria can be introduced, and alternate routing can be specified so that a call can re-route
automatically if the primary route or outgoing line group is not available. Although not shown in
this section, ARS also facilitates more specific dialed telephone number matching, enabling
immediate routing and alternate treatment for different types of numbers following the access code.
For example, if all 1+10 digit calls following an access code should use the SIP line preferentially,
but other local or service numbers following the access code should prefer a different outgoing line

group, ARS can be used to distinguish between these call behaviors.

To add a new ARS route, right-click ARS in the Navigation pane and select New. To view or edit
an existing ARS route, select ARS in the Navigation pane, and select the appropriate route name in
the Group pane.

The following screen shows an example ARS configuration for the route named “Main”. The In
Service parameter refers to the ARS form itself, not the Line Groups that may be referenced in the
form. If the In Service box is un-checked, calls are routed to the ARS route name specified in the
Out of Service Route parameter. [P Office short codes may also be defined to allow an ARS route
to be disabled or enabled from a telephone. The configurable provisioning of an Out of Service
Route, and the means to manually activate the Out of Service Route, can be helpful for scheduled

maintenance or other known service-affecting events for the primary route.

P omees ars I T
KR BOOTP (3 Mame Time Profile ARS
% Operator (3) " Main
=)+ ODEOOFOSB33F ARS Route Id Secondary Dial tone
“ap Syskem (1)
T4 Line (5} Raute Marme SystemTone b
= Control Unit {43
? Extension (22) Dial Delay Time System Default (4) 5 Check User Call Barring
User (23}
-3“ HuntGroup (3)
g ghan CD(S)E (59) In Service Otk of Service Route =Mone >
arvice
AL RAS (1) |
@ Incoming Call Route (4)
8 wanPaort (0) Time Profile ey 0 OF Hours Route =MNone >
swm Direckory (0)
f.“ Time Profile {0} l
Fi Il Profile (1
g I::‘:jte E;)I = Code Telephone Mumber Feature Line Group Id L E
B Account Code (00 11 211 Dial Emergency o
& Licence (641 911 911 Dial Emergency il i
% Tunnel (0) [ on Dial 3K1 17
§ 3 User Rights () 1N; 1N"@E4, 199,64, 220" Dial 3k1 17
i Auto Attendant (0) XM; M Dial 3K1 ]
T ARS (1) AN M Dial 31 il
# RAS Location Request { At P —— el s . b
fx E911 System (1) < >
— Additional Route <Monex
< >
' '
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Assuming the primary route is in-service, the number passed from the short code used to access ARS
(e.g., 6N in Section 5.5) can be further analyzed to direct the call to a specific Line Group ID. Per
the example screen above, if the user dialed 6-1-713-555-1212, the call would be directed to Line
Group 17, the SIP line configured and described in these Application Notes. If Line Group 17
cannot be used, the call can automatically route to the route name configured in the Additional
Route parameter in the lower right of the screen (not configured for the compliance test). Since
alternate routing can be considered a privilege not available to all callers, IP Office can control
access to the alternate route by comparing the calling user’s priority to the value in the Alternate
Route Priority Level field.

5.9. Privacy/Anonymous Calls

For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling party
number in the From and Contact headers of the SIP INVITE message with “restricted” and
“anonymous” respectively. Avaya IP Office can be configured to use the P-Preferred-Identity (PPI)
or P-Asserted-Identity (PAI) header to pass the actual calling party information for authentication
and billing. For the compliance test, PAI was used for the purposes of privacy.

To configure Avaya IP Office to use PAI for privacy calls, navigate to User = noUser in the
Navigation / Group panes. Select the Source Numbers tab in the Details pane. Click the Add
button. At the bottom of the Details pane, the Source Number field will appear. Enter

SIP _USE PAI FOR _PRIVACY. Click OK.

IP Offices User ﬁ NoUser: gf - X wvl<]|>
! Extensi
R B00TP (3) L BN | ser | voicemail | DND || Shortcodes | Source Numbers Telephony || Forwarding | Dial In | Woice Recording || Button Progr € ¥
i Operator (3) Analog Phone 028
=+ OOEOO7OSE33F Digital 1405 FT0E Source Mumber Add...
39 System (1) e Exkn302 302
T Line (5) Extna03 303 RER
= Control Unit (4) Extn77023 77023 J
& Extension (22) Extn77024 77024 Edt...
%:SEEES) - Extn7 7025 77025
unkGroup
Exkn77026 77026
¢ Short Code (39) Extn77027 77027
@ service (0) Exkn77029 Fr029
o RAS (1) o
e Incoming Call Route (4] Extn77030 77030
@ WanPart (0) Exkn77031 77031
s Directary (0) Extni77032 77032
g"“\ Time Profile (0) Extn77033 FIO033
@ Firewal Profile (1) Extn77034 7034
Bl 1P Route (3) Exkn77035 77035
| Account Code (0) Extn77036 FT036
W Licence (64) Extn77037 77037
i Tunnel {00 mHIZ3 1616 301
§_} User Rights (8} = 1PO Softphone 307
_:“ Auto Attendant (0) g Holser Mew Source Mumber
l\’ ARS (1) ) ;RemoteManager
f RAS Location Request ﬂHSIP 1120E 401 Source Number SIP_USE_PAI_FOR_PRIVAC\"|
fix E311 System (1)
(o]
< ¥ [£ ¥
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The SIP_USE_PAI _FOR_PRIVACY parameter will appear in the list of Source Numbers as
shown below.

W —

= NoUser: e - X[ w <>

Menu Programming | Mohbility | Phone Manager Options | Hunt Group Membership | Announcements | SIP Personal Direckary

User || Woicemail | DMD || ShortCodes | Source Mumbers | Telephory | Forwarding || Dial In || Yoice Recording | Butkon Programming

SIP_IUSE_PAl_FOR,_PRIMACY
Remove

5.10. SIP Options

Avaya IP Office sends SIP OPTIONS messages periodically to determine if the SIP connection is
active. The rate at which the messages are sent is determined by the combination of the Binding
Refresh Time (in seconds) set on the Network Topology tab in Section 5.1 and the
SIP_OPTIONS_ PERIOD parameter (in minutes) that can be set on the Source Numbers tab of the
NoUser user. The OPTIONS period is determined in the following manner:

e [fno SIP_OPTIONS PERIOD parameter is defined and the Binding Refresh Time is 0,
then the default value of 42seconds is used.

e To establish a period less than 42 seconds, do not define a SIP_OPTIONS PERIOD
parameter and set the Binding Refresh Time to a value less than 42 secs. The OPTIONS
message period will be equal to the Binding Refresh Time.

e To establish a period greater than 42 seconds, a SIP_OPTIONS_PERIOD parameter must
be defined. The Binding Refresh Time must be set to a value greater than 42 secs. The
OPTIONS message period will be the smaller of the Binding Refresh Time and the
SIP_OPTIONS_PERIOD.

To configure the SIP_OPTIONS_ PERIOD parameter, navigate to User = NoUser in the
Navigation / Group panes. Select the Source Numbers tab in the Details pane. Click the Add
button.

IP Offices User B NoUser: ef -l X[ wvl<]>
I Extensi
K BOOTR (3) ame HEENEIOn User Yaicerail | DND ShortCodes | Source Mumbers | Telephony | Forwarding | Dial In || Yoice Recording | Button Progr 4
{7 Operator (3} Analog Phone FTOZE
=%y OOEQO7OSESSF Digital 1408 Frozz Source Mumber Aﬁ
59 System (1) i Extnalz 302 SIP_USE_PAI_FOR_PRIVACY
4 Line (5} Exbniais 303 FEmEe
< Control Uinit (4) Extn?70Z3 77023 7
@ Extension (22) Extn77024 77024 Edt...
% :531223) - Extn77025 77025
unkGroup
Extn77026 =)
Short Code {59
g S;\:ic:(o)e( ) Extn77027 77027
AL RAS o Extn770z9 Froz9
e Incoming Call Route (4] Extn77os0 77050
@ wWanPort {03 Extn77031 77031
s Directory (0) Extn77032 77052
rl‘\ Time Profile {03 Extn77033 7033
@ Firewall Profile (1) Extny7034 F034
El 1P Route (3) Extn77035 77035
W Account Code (0) Extn77036 FFOIE
W Licence (64) Extn77037 FIO0ST
% Tunnel {0} mH323 1616 301
§ User Rights (23 = IFO Softphone 307
i Auto Attendant {00 Sratiolser
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«#~ RAS Location Request ="'SIP 1120E 401
= E911 System (1)
Hel)
< sl >
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At the bottom of the Details pane, the Source Number field will appear. Enter
SIP_OPTIONS_PERIOD=X, where X is the desired value in minutes. Click OK.

L1 & 1

¥ NoUser: ° ETFT|K|~/|‘=:|>]‘

User | woicemail | DMD || ShortCodes | Source Mumbers | Telephony | Forwarding | Dial In || Woice Recording | Button Progr € *
”

Edit Saurce Murmber
K

SIP_OPTIONS_PERIOD=1

Source Mumber
L

Help

The SIP_OPTIONS_PERIOD parameter will appear in the list of Source Numbers as shown
below. For the compliance test, an OPTIONS period of 1 minute was desired. The Binding
Refresh Time was set to 60 seconds (1 minute) in Section 5.1. The SIP_OPTIONS_PERIOD
was set to I minutes. Avaya IP Office chose the OPTIONS period as the smaller of these two
values (1 minute). Click the OK button (not shown).

B vuee  CEEIMEE

User | Woicemail | DMD || ShortCodes | Source Numbers | Telephony | Forwarding || Dial In | Voice Recording || Button Progr € %

LS

SIP_USE_PAL_FOR_PRIVACY
SIP_OPTIONS_PERICD=1

Remove

Edit...

W

5.11. Save Configuration
Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. PaeTec SIP Trunking Configuration

PaeTec is responsible for the configuration of PaeTec SIP Trunking service. The customer will need
to provide the IP address used to reach the Avaya IP Office at the enterprise. PaeTec will provide
the customer the necessary information to configure the Avaya IP Office SIP connection to PaeTec.
The provided information from PaeTec includes:

e [P address of the PaeTec SIP proxy.
e PaeTec SIP domain

e Supported codecs

e DID numbers

[ ]

7. Verification Steps

The following steps may be used to verify the configuration:

IP addresses and port numbers used for signaling or media through any security devices.

e Usethe Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start = Programs > IP Office > System Status on the PC
where Avaya [P Office Manager was installed. Select the SIP line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State is Idle for each
channel (assuming no active calls at present time).
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e Seclect the Alarms tab and verify that no alarms are active on the SIP line.

AVAyA IP Office System Status

Help Snapshot  LogOff  Exit  About

B System
B & Alarms (1)
ons (10)
B Trunks (5)
Lines:1-4
»

Active Calls

Status  Ukilization Summary Alarms |Registration

Alarms for Line: 17 SIP cust2-tor.vsac.bell.ca

Last Diate OF Errar Qocurrences Error Description

E Resources

B Voicemail
E IP Networking

Fing Clear Clear. Al Prick. .. Save A5,

e Verify that a phone connected to PSTN can successfully place a call to the Avaya IP Office
with two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.

e Using a network sniffing tool (e.g., Wireshark), monitor the SIP signaling messages between
PaeTec and Avaya IP Office on an outbound call from the enterprise to the PSTN.

8. Conclusion

The PaeTec SIP Trunking service passed compliance testing. These Application Notes describe the
procedures required to configure the SIP connection between Avaya IP Office and the PaeTec SIP
Trunking service as shown in Figure 1.

9. Additional References

[1] IP Office 7.0 IP Office Standard Version Installation, Document number15-601042, March
2011.

[2] IP Office Release 7.0 Manager 9.0, Document number15-601011, April 2011.

[3] IP Office Release 7.0 Voicemail Pro Installation and Maintenance, Document Number 15-
601063, March 2011.

[4] IP Office Release 6.0 System Status Application, Document number15-601758, February 2010.

[5] IP Office System Monitor, Document Number 15-601019, November 28, 2008

Product documentation for Avaya products may be found at http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/

Product documentation for PaeTec SIP Trunking is available from PaeTec.
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products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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